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1 INTRODUCTION 
This document describes the TLON Manager kit, type number 5095. 

The document describes how to install the PC program TLON Manager V2.0.x. It also describes how to 

create a new TLON project, how to install it, and the maintenance of a TLON Network. It is not a 

complete description of the TLON Manager. Basic knowledge of windows and windows applications are 

required as well as knowledge of the fire alarm system.  

 

2 ABBREVIATIONS 
c.i.e Control and indicating equipment = control unit 

Nodes EBL512 G3 / EBL512 control units  
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3 GENERAL DESCRIPTION 
TLON Manager 2.0 is the software with which a TLON project is created and installed into the networks 

units. It is also used for maintenance of the TLON Network. 

 

For connection to the TLON Network a USB Network interface is used. 

 

TLON Networks are used for fire alarm systems EBL512 G3 and EBL512. Each c.i.e. in the network has 

to have at least one TLON connection board.  

 

 EBL512 G3 EBL512 

Main board 5010/5012 1556 

TLON connection board 5090 5090/1590 
 

 

3.1 TLON MANAGER KIT 
The TLON Manager kit contains the following: 

• U10 USB Network interface type 75010R 

• Network connection cable (1.5 meter) 

• USB Memory stick 

• USB extension cable (0.6 meter) 

• License (for 64 credits per computer) 

 

The USB Memory stick contains the Echelon LNS Server 3.27, the TLON Manager V2.0.x software, the 

OpenLDV driver and documents. 
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4 ECHELON LNS SERVER 
4.1 INSTALLATION OF THE ECHELON LNS SERVER 
Before installation, be sure that no other application is running on your computer. 

NOTE! It is highly recommended to uninstall any old TLON Manager version and also the drivers 

(Echelon OpenLDV x.xx) before the installation of Echelon LNS Server and TLON Manager 2.0. 

It is also important that Echelon LNS Server is installed before the installation of TLON Manager 2.0.x. 

 

a) Put the USB Memory stick in one of the computers free USB port. 

b) Select the LNS Server 3.27 folder. 

c) Double click the setup.exe file and follow the installation instructions.  
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5 INSTALLATION OF TLON MANAGER 
Before installation, be sure that no other application is running on your computer. 

 

NOTE! It is important that before the installation of TLON Manager 2.0, the Echelon LNS Server is 

installed, see chapter 4. ECHELON LNS SERVER. 

 

a) Before installation of version – V2.0.x, uninstall any other version of TLON Manager V2.X.x. 

b) Select the TLON Manager 2.0.x folder. 

c) Double click the Setup.exe file and follow the installation instructions. 

d) Press Finish to finish the TLON Manager installation. 

 

The program will normally be installed in the following folder: 

C:\Program Files\Panasonic Electric Works Nordic AB\TLON Manager 2.0.x 

 

NOTE! After a program installation it is always recommended to restart the computer. 

 

It is also recommended to check that the path is correct.  

 

5.1 TLON MANAGER 2.0.1 IN WINDOWS 10 
Not been installed before 

a) Install .Net Framework 3.5 by using going to Program and Features and press Turn Windows 

features on or off. 

b) Press the .Net Framework 3.5 (includes 2.0 and 3.0). Windows update will download necessary 

files and install. 

c) Install OpenLDV 5.1 (OpenLDV510.exe) and reboot computer after installation of OpenLDV. 

d) Install LNSServer 3.27. 

e) Install TLON Manager 2.0.1  

f) Reboot the computer after installation. 

NOTE! It is very important to reboot the computer after the installation. 

g) The installation is now completed. 

 

Installed before but not working 

a) Install OpenLDV 5.1 (OpenLDV510.exe) and reboot computer after installation (OpenLDV may 

ask to reboot). 

b) Uninstall and re-install LNSServer 3.27 and reboot. 

c) The installation is now completed. 

6 ECHELON OPENLDV DRIVER 
The installation of the driver (OpenLDV ≥ 4.00) is necessary to support 64-bit windows version. If a 32-

bit windows version is used, this installation is optional. 

NOTE! To support 64-bit windows versions TLON Manager V2.0.1 or later is necessary. 
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6.1 INSTALLATION OF THE ECHELON OPENLDV DRIVER 
An older version of the driver (OpenLDV 3.4) is automatically installed during the installation of Echelon 

LNS Server 3.27. Before installation of the new driver (OpenLDV ≥ 5.00), uninstall the old driver 

(OpenLDV 4). 

 

a) Select the OpenLDV x.xx folder. 

b) Double click the OpenLDVXxx.exe file and follow the installation instructions. 

c) Connect the USB Network interface U10 to an available USB port. The installation of the USB 

driver should start automatically. If a Windows Update dialog box tells you to install the driver, 

choose any of the three Windows update options.  

d) Press Next to continue. 

e) Select Install the software automatically (Recommended). 

f) Press Next to continue. A dialog box appears. 

g) Press Finish. 

 

7 PROJECT 
Normally, the network planning is carried out in the office, and during the commissioning on site, the 

TLON Network installation can be performed. As an alternative, the planning and installation can be 

carried out on site at the same time. 
 

7.1 PLANNING A PROJECT 
A TLON Network can consist of two or up to thirty EBL512 G3 units. 

 

In an EBL512 G3 TLON Network are normally, for safety reasons, routers used. 

 

It is possible to have one TLON Network with a mix of EBL512 G3 and EBL512 units, a so called mixed 

system. In such a case the EBL512 G3 units have to have the software United version 2.7.x. and the 

EBL512 units have to have the software version 2.7.x.  
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7.1.1 EBL512 NETWORK 
For safety reasons, it is recommended not to have more than six nodes on one channel.  To get one 

more channel, a router has to be added, i.e. one router per six EBL units.  A router can also be added in 

order to obtain a total cable length that is two times the normal cable length for one channel. 

In rough outline, there are three types of networks: 

1)  Up to six nodes on one channel, i.e. no router.  

2)  Up to twelve nodes and one router, i.e. one router and two channels.   

3)  Up to thirty nodes and a number of routers, connected to each other via a backbone net. 

Make a schematic drawing of the network, i.e. a drawing showing all the nodes, cables, channels and 

required routers. The fire alarm system's installation drawings can be useful as well as the planning 

made with Win512, for example system name, c.i.e. numbers, cables, etc. 

For safety reasons, it is recommended to place all the routers and the backbone net together in a locked 

cabinet / room. See also chapter 15. EXAMPLES. 

7.1.2 EBL512 G3 NETWORK 
Redundant network 

For safety reasons the EBL512 G3 units have the possibility to use two TLON connection boards in 

order to get two parallel TLON Networks, a so called redundant network. 

In a redundant network two projects have to be created and installed.  The projects have to be identical 

but with different project names.  One has to be installed for network no. 0 and one installed for network 

no. 1. 

 

Normally, TLON Network no. 0 is used for communication and TLON Network no. 1 will be used for 

communication only in case of a fault condition (cut-off or short circuit) on TLON Network no. 0. 

If a redundant network is used there is no need for routers if not a cable length longer than the normal 

cable length for one channel, is required (see type B below). 

7.1.3 CHANNELS 
Two or more nodes are physically connected to each other via a network cable. In the LonWorks 

vocabulary this is called a channel (compare with a COM loop and connected loop units). 

In EBL512 G3 one board per TLON Network. One TLON connection board is required in each EBL512 

unit. 

 

In a network type A there is only one channel. No channel has been added, channel 1 is default. 

In a network type B there is one channel on each side of the router. 

In a network type C there is one channel for each router and one channel for the backbone net between 

the routers. Required number of channels has to be added. 
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7.1.4 ROUTERS 
After the channels have been added, the routers have to be added to the project if it is a type B or C 

network. Use channel_2 for the backbone net. 

7.1.5 EBL512 G3/ EBL512 UNITS 
After the channels and routers have been added, the units have to be added to the project, see chapter 

11. ADD A UNIT. 
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8 CREATE A NEW PROJECT 
This example will show how to connect two EBL512 G3 / EBL512 units (CU00 and CU01) in a TLON 

network. 

 

Start TLON Manager by double clicking the  icon on your computer. 

 

a) In the File menu choose New….  
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b) Type the name of the project. Normally use the same name as the “System name” in Win512 / 

WinG3. 

The path will be automatically created when you type in the name. 

NOTE! Do not change this data base path. 

c) Select Network interface: 

Engineered Mode: This mode shall be selected when TLON Manager is not connected to any 

TLON Network, for example when creating a new project in your office. 

 

LON1 This is the TLON USB Network interface for TLON Manager 2.0 installed on your 

computer. Normally only one interface is installed but if also TLON Manager 1.x is installed, 

LON1 might be used for that interface. 

Select this interface (LON1) when you shall connect TLON Manager to a TLON Network. 

 

PCCLON1 This is the TLON Network interface (PCMCIA card) for TLON Manager 1.x (shown 

only if installed on your computer). Must not be used for TLON Manager 2.0. 

 

d) Press OK to save the settings and close the dialog box. In the TLON Manager 2.0 window is 

now displayed the Project (system_xyz) and the Path (C:\lm\db\System_xyz): 
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e) Now the EBL512 G3/ EBL512 units have to be added. In the Network menu choose Unit… or 

press Add. In this example, no channels have to be added. The following dialog box displays: 

 

 

Name 

Use the default name or type a new name. 

 

Number 

The number can be 00-29, for example CU00-CU29. Normally use the same number as in the name. 

 

Type 

Select EBL512 /EBL512 G3 for an EBL512 G3/ EBL512 unit or select TLONDDE Server for a 

TLONDDE Server (for a security management system).   

NOTE!  Only valid for "Unit_29" (Number 29). 

Select Securimaster 1.43 connection only for Securimaster 1.43.   

NOTE!  Only valid for "Unit_29" (Number 29). 

 

Channel 

See chapter 7.1 PLANNING A PROJECT. Select a channel in the list. In this example, select "Channel_1" 

(default). 

 

Description 

A description of the node may be written here.  Maximum 64 characters divided on three rows. 
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f) Press OK to save the settings and close the dialog box.  

g) Add the wanted number of nodes the same way.  

The window shows the Project “System_xyz” with two units (Unit_0 and Unit_1) on channel_1. 

Status “No Response” shows that the units are not installed / not responding. 

 

h) In the File menu choose Close and close the project. 

 

The project is now created and can later be installed. 
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8.1 INSTALLATION OF A PROJECT 
The TLON Network cable installation has to be finished and the nodes connected to the TLON Network. 

NOTE! In a project with routers, they have to be installed before the nodes, see chapter 10.1 

INSTALLATION OF ROUTERS. 

 

a) Plug the TLON USB network interface cable into any of the nodes on the channel_1. From now 

on, it is recommended to use the same channel at all times. 

The modular connector (RJ-45) “J2” in EBL512 (is situated below and to the right of the keypad 

on the EBL512 front) / “J10” – Network no. 0 and “J11” – Network no. 1 in EBL512 G3 (situated 

down to the right on the main board) are to be used. 

 

b) Press the drop down button to see the list of projects and select one. 

c) Press the drop down button to see the list of network interfaces and select one, normally LON1. 

 

d) Press OK. 
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In this example we have no routers and only one channel, Channel_1. (routers have to be installed 

before the nodes). 

e) Select a unit, press Install and the following window will be displayed: 

 

f) Press Yes and the following dialog box displays: 

 

g) In the nodes that is intended to be number zero (CU00), shunt momentarily the “Service” pins, in 

EBL512 “JP 3” on the main board  / in EBL512 G3 “JP 1” (for Network no.0) or “JP 2” (for 

Network no. 1) on the main board.  A “Neuron ID (number) will be transmitted and for a second 

shown in the “Neuron ID” field. 

Since the check box Start installation automatically when service message is received is 

checked, TLON Manager will automatically start binding the node in the database. 

If the check box is un-checked you will have to press OK to continue.  The time is depending on 

the number of nodes. 

The EBL512 G3/ EBL512 “Unit_0” is now created and installed in the network. To check this you 

can select the EBL512 G3/ EBL512 unit and press Wink.  The buzzer in the EBL512 G3/ 

EBL512 unit shall sound for approximately one second.  

When the binding process is completed, the “Status” will be “CnfgBypass” until all units are 

“Online” 

h) Do the same for the EBL512 G3/ EBL512 “Unit_1”. 

i) In this example all the units are now installed. Press Update all. TLON Manager will now re-

connect and update all the units installed in the network. The network information will now also 

be saved in each EBL512 G3/ EBL512 unit, one by one. (Some information will be saved in the 

TLON connection board memory and some in the Main board memory). 

j) Press All Online when all nodes are updated. 

k) It is highly recommended to restart each EBL512 G3 / EBL512 unit. 
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9 ADD A CHANNEL  
Regarding channels in a TLON Network, see chapter 7.1 PLANNING A PROJECT.  

In the Network menu choose Channel... and the following dialog box displays. 

 

Name 

Enter the name of the next channel in order to be added. Normally the default name is used but can be 

changed. 

Type 

The type used with EBL512 / EBL512 G3 units is TP/FT-10 (default). 

If a fibre optic network is to be used (via Fibre Optic/Twister Pair LonWorks Routers), the type is FO-10. 

Other units may use other types of communication. 

Existing 

A list of the existing channels in the project. 

Add 

Press Add to add the channel shown in the “Name” field. 

Remove 

The selected channel will be removed from the list. 

Close 

Save the data and close the dialog box when the required number of channels is added.  
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10 ADD A ROUTER 
Regarding routers in a TLON Network, see chapter 7.1 PLANNING A PROJECT. 

 

Two or more routers have to be connected via a “Backbone net”. Use channel_2 for the backbone net. 

 

In the Network menu choose Router… and the following dialog box displays: 

 

Name 

Default is "Router_1".  Write another name or add some information for the router (for example 

Router_1. Building A, Level 1). 

Type 

Repeater  This type should normally be selected.  (No learning function.  All messages except 

faulty messages will go through.) 

Learning Router  This type could be selected.  It learns – after some time – the messages that 

shall go through to the other channel. (Only the required messages and no faulty messages will 

go through. Learns if a new unit is added to the channel.) 

Configured Router  This type could be selected.  It has no learning function.  (The programming 

is followed to 100% and no faulty messages will go through.) 

Bridge  Not used in a TLON Network. 

Permanent Repeater  Not used in a TLON Network. 

Permanent Bridge  Not used in a TLON Network. 

 

Near, Far 

A router must be installed between two channels.  If there is only one channel in the list, a new channel 

must be added before a router can be added, see chapter 9. ADD A CHANNEL. 
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A router has connections for one Near channel (for example Lon A) and one Far channel (for example 

Lon B).   

Select a channel in the drop-down list respectively. 

Near:  On Router_1, the channel where the TLON Manager PC is to be connected (often Unit_0 

on Channel_1).  On any other router, the channel nearest Router_1. 

Far:  On Router_1, the Backbone net channel (Channel_2).  On any other router, the channel on 

the other side of the router respectively. 

Press Add to have the router shown in the list. 

"List field" 

A list of the existing routers in the project.  

Name  The name of the router. 

Type  Type of router. 

Near  Near Channel. 

Far  Far Channel. 

Status  No response / CnfgBypass / Online / Offline 

Add 

Adds the router, type and channels to the list ("List field"). 

Remove   

Removes (deletes) the selected router (in the "Name" column). 

Install 

Installs the selected Router (in the "Name" column).  A dialog box "Install" displays.  See chapter 

10.1INSTALLATION OF ROUTERS below. 

Reset 

Sends a reset message that will clear some statistics and configuration data. 

Update 

Updates the selected router.  See "Update" below. 
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Replace 

When an existing Router has to be replaced, you do not have to remove (delete) the existing Router and 

then add a new Router.  Replace will start the same procedure as for "Install".  See chapter 

10.1INSTALLATION OF ROUTERS below. 

Status 

The status for the selected router (in the "Name" column) will be shown in the "Status" column. 

Close 

Will save and close the dialog box.   

 

10.1 INSTALLATION OF ROUTERS 
The TLON Network cable installations have to be finished and the routers have to be power supplied 

and connected to the network. 

NOTE! The routers have to be installed before the EBL512 / EBL512 G3 units can be installed 

otherwise there will be no communication with the units connected on the channels “on the other side” 

of the router. 

 

Plug the TLON USB network interface cable into any of the EBL512 / EBL512 G3 units on Channel_1. 

From now on, it is recommended to use the same channel at all times. 

The modular connector (RJ-45) “J2” EBL512 / “J10” – Network no. 0 and “J11” – Network no. 1 in 

EBL512 G3 are to be used. 

 

a) Start TLON Manager. In the File menu choose Open. 

b) Select Project and Network Interface (normally LON1) and press OK. 

c) In menu Network select Router…. 

d) In the dialog box select a router and press Install. 

The following dialog box will be displayed: 

 

e) Press Yes and a dialog box will display. 
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On the specified router, push the "Service" button.  A Neuron ID (number) will be transmitted 

and (for a second) shown in the "Neuron ID" field. 

Since the check box "Start installation automatically when service message is received" is 

marked, TLON Manager will automatically start binding the router in the database. 

If the check box is un-marked you will have to press OK to continue.    

The Router_1 is now created and installed in the network.  When the binding process is 

completed, the "Status" will be "CnfgOnline".  

f) When all routers are installed, press Update all. TLON Manager will now re-connect and update 

all the routers installed in the network. 

g) When all routers are installed, the EBL512 G3/ EBL512 units can be installed, see chapter 8.1. 

INSTALLATION OF A PROJECT. 
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11 ADD A UNIT 
Regarding nodes in a TLON Network, see chapter 7.1 PLANNING A PROJECT, and section 7.1.5 EBL512 G3/ 

EBL512 UNITS.  

In the Network menu choose Unit… or press Add. 

The following dialog box displays: 

 

The dialog box and the following actions are described in the example in chapter 8. CREATE A NEW 

PROJECT and continues in chapter 8.1. INSTALLATION OF A PROJECT. 

 

NOTE!  When all the nodes have been installed, it is very important that you press Update all and All 

Online as described in the example.  After that it is recommended to restart each node. 
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12 FILE MENU 

 

12.1 NEW 
Creates a new Project, see chapter 8. CREATE A NEW PROJECT. 

 

12.2 OPEN 
Open an existing project in TLON Manager´s common data base. Select a project in the list, select a 

Network interface, and press OK. 

 

12.3 CLOSE 
Close and save the project that is open. 

 

12.4 DELETE 
Deletes an existing project in TLON Manager´s common data base. In the list, select the project to be 

deleted and press OK.  

 

12.5 IMPORT 
To be able to open a project that for example has been copied from another computer or to be able to 

open an “old project” when a new version of TLON Manager has been installed, the project has to be 

imported to TLON Manager´s common database. 

Select “Import…” and the following dialog box displays: 

 

Find and select the folder (Project) to be imported.  As default, TLON Manager 2.0 saves all projects in:  

C:\lm\db\. 

As default, TLON Manager 1.x saves all projects in:  C:\lns\. 

The project name will be the same as the folder name.  You may use this name or change it. 
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12.6 EXPORT 
Used when you want to export a project. You will get a copy of the project in another folder. From this 

folder it is possible to copy the project. Export can also be used if you want to backup of the project  

or want to use the project in another computer. 

NOTE!  It is not possible to "upload" data from the TLON Network to TLON Manager. 

a) Select Export… and the following dialog box will display: 

 

b) Select a project to export  

c) Press OK. 

 

d) Find and select the folder to which the project is to be exported (As default, TLON Manager 

suggests:  C:\lm\db). 

The "File name" (Project name) will be the same as the folder name.  You may use the current 

name or change it. 

e) Press OK.  The project will now be copied to the selected folder. 
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12.7 COPY PROJECT 
Used when you want to copy of an existing project, but with a new name. This is useful when a new 

similar project is to be created. 

a) Select Copy project… and the following dialog box will display: 

 

b) Select the project to copy. 

c) Press OK. The following dialog box will display: 

 

d) Press Save and the project will be copied. 

 

12.8 EXIT 
Select Exit to close TLON Manager 2.0. 

NOTE! Close any open project before exiting TLON Manager.  
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13 REMOVE 
Everything added to the network, for example EBL512 G3/EBL512 units, channels, and routers may 

also be removed. 

 

NOTE! After removing something you have to “Update all”. 

 

13.1 REMOVE EBL512 G3/ EBL512 UNIT 
There are two ways to remove a node: 

a) Select the unit to be removed and press the right mouse button to get a pop-up menu. 

b) Select Remove. 

c) Select the unit and press Remove. 
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13.2 REMOVE CHANNELS 
In the Network menu select Channel…. The following dialog box will display: 

 

Select the channel to remove and press Remove. 

 

13.3 REMOVE ROUTERS 
In the Network menu select Routers…. The following dialog box will display: 

 

Select the router to remove and press Remove. 
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14 MAINTENANCE AND TROUBLESHOOTING 
Some TLON information is saved in the TLON connection board memory and some in the EBL512 G3/ 

EBL512 Main board memory.    

- If only the Main board is replaced:  Perform an Update for the unit.  (Select the unit, right press and 

select "Update" in the pop-up menu.)  

- If the TLON connection board is replaced:  Perform a Replace for the unit. 

There are a number of functions that are useful for network maintenance and troubleshooting.  The 

most common are described below.   

 

14.1 INSTALL 
The unit will be installed in the network, see chapter 8.1. INSTALLATION OF A PROJECT and chapter 10.1 

INSTALLATION OF ROUTERS. 

 

14.2 ONLINE 
The selected unit can be set Online if the status is CnfgBypass (Offline). 

 

14.3 WINK 
With "Wink" you can check that the EBL512 G3/ EBL512 unit corresponds to the selected unit in TLON 

Manager 2.0.  A not connected node, not installed, etc. cannot receive a wink message. 

There are two ways to send a wink message: 

• Select the unit and click the right mouse button to get a pop-up menu. Select “Wink”. 

• Select the unit and press Wink. 
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EBL512 

In the selected node the wink message turns on the buzzer and all the front LEDs for approximately 1 

second. 

 

EBL512 G3, Network no. 0 

In the selected node the wink message turns on the buzzer and the front LED "Test mode" for 

approximately 0.4 second. 

 

EBL512 G3, Network no. 1 

In the selected node the wink message turns on the buzzer and the front LED "Test mode" for 

approximately 2 second. 

 

14.4 STATUS 
Status for the selected node will be updated, for example, no changes no change of the status. 

 

14.5 UPDATE 
Normally you update a unit (i.e. the network configuration data is downloaded to the physical unit) after 

it has been installed, see chapter 8.1. INSTALLATION OF A PROJECT.   

 

Update can also be used when you suspect that the configuration data in a unit is incorrect. 

When a Main board is replaced in an EBL512 G3/ EBL512 unit, the unit has to be updated. 

Select the unit and click the right mouse button to get a pop-up menu.  Select "Update". 

After "Update" the information is: 
OK(0) = Update OK  (0 unsuccessful attempts) 
OK(1) = Update OK  (after 1 unsuccessful attempt) 
OK(2) = Update OK  (after 2 unsuccessful attempts) 
NG = Update not good 

14.5.1 UPDATE ALL 
All the units in the Network can be updated (see above) with only one command.  Press Update all, see 

also chapter 8.1. INSTALLATION OF A PROJECT. 

 

14.6 REPLACE 
When a TLON connection board is replaced in an EBL512 G3/ EBL512 unit, select the unit and press 

Replace.   

 

14.7 MOVE 
A node can be moved from one channel to another.  In the dialog box that opens, specify the "New 

location" (Channel) and press OK. 

NOTE!  The channels have to be added before. 

 

14.8 OFFLINE 
The selected unit can be set Offline (CnfgBypass) if the status is (Online). 
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14.9 RESTART 
You can restart a unit in the network with the restart command.  In a TLON Network this command 

works only with EBL512 G3/ EBL512 units. 

Select the unit and click the right mouse button to get a pop-up menu.   

Choose Restart and the following dialog box displays: 

 

Press Yes to restart the unit. 

14.9.1 RESTART ALL UNITS 
You can restart all the units in a TLON Network. 

In the menu All units choose Restart and the following dialog box displays: 

 

Press Yes to restart the units. 
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14.10 DETAIL INFORMATION 
This command asks a unit in the Network a series of questions, which will be presented in a dialog box. 

Select a unit and click the right mouse button to get a pop-up menu.   

Choose Detail Info and the following dialog box displays: 

 

The dialog box contains a lot of information and a deeper knowledge of the TLON Network is required to 

be able to understand some of it. The information of interest for the average user is explained below.

  

(In case of no contact, the information is:  "No contact with node".) 

 

Name 

The name given to the unit when it was created. 

Type 

The type given to the unit when it was created, see chapter 8. CREATE A NEW PROJECT.   

(If an old project is opened in TLON Manager 2.0.x the type shown here might be different than 

the type given to the unit when it was created.) 

Status 

Shows the status of the unit.  The normal status is "CnfgOnline". 

Neuron ID 

The TLON connection board Neuron ID number. 

Channel  

Shows the Channel the unit is installed on, for example Channel_1. 

Unit Number 

The number given to the unit when it was created. 
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Description 

The Description given in the "Create unit" dialog box (if any). 

 

Last reset cause 

Shows the reason for latest restart of the unit. 

 

Transaction Timeouts 

Shows the number of messages sent but not acknowledged by all other nodes in the network.  

The number should be 0 after the unit has been installed.  The number may increase if new units 

are installed.  Reset the value (and all the others) by pressing Reset. 

 

Transmission Errors 

After a reset of values (by pressing Reset):  Must not increase during a 10-minutes interval. 

 

Test 

Shall normally be "Good". 

 

14.11 PROPERTIES 
Select a unit and click the right mouse button to get a pop-up menu.   

Choose Properties and the following dialog box displays: 

 

Press OK to save and close the dialog box. 
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15 EXAMPLES 
Some examples of TLON Networks: 

 

Two networks with eight EBL units. 

 

System EBL512      System EBL512 G3 

> 6 units, i.e. one Router    Redundant network 

is required.     i.e. two networks. 

Channel_1 and Channel_2   Channel_1 

 

 512      512 G3 

   |        |    | 

 512      512 G3 

   |        |    | 

 512      512 G3 

   |        |    | 

 512      512 G3 

   |        |    | 

 Router_1     512 G3 

   |        |    | 

 512      512 G3 

   |        |    | 

 512      512 G3 

   |        |    | 

 512      512 G3 

   | 

 512 

 

Each Channel has to start and end with a termination resistor, 105R, 1%, 1/8W. 
 
An example of an EBL512 network with three Routers connected via a Backbone net.  Four Channels 
are required. 
 
    Channel_2  (Backbone net) 
 
 Router_1 -------------------------------- Router_2 ----------------------------- Router_3 
    |          |         | 
 512       512      512 
    |          |         | 
 512       512      512 
    |          |         | 
    |          |         | 
 Channel_1   Channel_3   Channel_4 
 
Each Channel has to start and end with a termination resistor, 105R, 1%, 1/8W. 
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16 LNS DEVICES CREDITS 
LNS Device credits only concerns previous TLON connection board (p.c.b. no. 9302-xx). Current TLON 

connection board as well as routers will not consume any LNS Device credit 

With every TLON Manager kit comes a license with 64 LNS Device credits. One LNS Device credits is 

consumed for each TLON connection board in the network. 

 

16.1 LICENSE STATUS 
In the File menu choose Open to open any project.  In the Help menu choose License status and the 

following dialog box opens: 

 

Days remaining: As long as there are LNS Device credits this field will show Sufficient credits. When 

all the LNS Device credits are consumed and TLON Manager has started to use "Deficit credits" this 

field will show the number of days (0-14) before the license will expire. If the number of days = 0 the 

LNS Server will cease to operate until new LNS Device credits are added. 

 

Deficit credits: As long as there are LNS Device credits this field will show 0. When all the LNS Device 

credits are consumed, TLON Manager will start to use Deficit credits. This field will then show the 

number of Deficit credits being used (0-500). 

 

Licensed credits: The number of LNS Device credits added.  

 

Licensed type: Always Standard Mode in TLON Manager V2.0. 

 

Max deficit credits: The number of "Deficit credits" allowed. If this number is exceeded, the LNS Server 

will cease to operate until sufficient LNS Device credits are added. 

 

Used credits: The number of the LNS Device credits consumed. This number does not include the 

number of "Deficit credits" currently being used. 
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16.2 HOW TO ORDER LNS DEVICES CREDITS 
Before the license will expire you should purchase additional LNS Device Credits.  Panasonic Electric 

Works Nordic AB's article number for additional LNS Device Credits is 5096 and corresponds to 50 LNS 

Device Credits.  

(It is also possible to order LNS Device Credits directly from Echelon.) 

In the Start menu you will find a program group Echelon LNS Utilities.   

 

a) Start the program LNS Server License Wizard. 

b) In the Credit Order frame enter the number of LNS Device Credits you want to add / purchase. 

c) Press Next >: 
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d) Press Copy to Clipboard. 

Open your email program (or word processor) and paste the clipboard contents (the Request 

form) into the email message (or document).   

e) Send that Request form together with your article number 5096 order to:  

Order.pewnf@eu.panasonic.com.  

 

If you order from Echelon directly, fill in the requested information in the Request form before 

you send it to credits@echelon.com. 

 

APPLICATION KEY  

You will receive an "Application Key" via a return email.   

f) Start the LNS Server License Wizard and proceed to the second dialog box containing the 

Copy to Clipboard button.   

g) Copy the Application Key from the return email into the Application Key field.   

h) Press Finish. 

 

  

mailto:Order.pewnf@eu.panasonic.com
mailto:credits@echelon.com
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16.3 REQUEST FORM – EXAMPLE 
The Request form shall be send together with the article 5096 order.  

NOTE!  If you order article number 5096, Panasonic ESN AB will fill in the requested information in the 

top part of the form.  If you order from Echelon directly, fill in the requested information. 

Here follows an example of a Request form generated by the "LNS Server License Wizard": 

YOU MUST FILL IN ALL THE BLANK FIELDS IN THE TOP PART OF THE FOLLOWING FORM, 

SELECT ONE OF THE BILLING OPTIONS BY FILLING IN A CHECKBOX IN THE BOTTOM PART OF 

THE FORM, AND FILL IN THE BLANK FIELDS IN THE SELECTED BILLING OPTION. IF YOU ARE  

ORDERING NO CHARGE CREDITS, YOU MUST FILL IN ONE OF THE CHECKBOXES EXPLAINING 

THE REASON FOR THE ORDER.  A BLANK FIELD IS A FIELD WITH A COLON (":") AT THE END OF 

THE LINE. IF ANY OF THIS INFORMATION IS MISSING, YOUR ORDER WILL BE DELAYED. 

TO:     Echelon License Administrator 

           Email:  credits@echelon.com 

           Fax:    +1-408-790-3833 

 

FROM:  Name:      

             Company:   

             Address1:  

             Address2:  

             Country:   

             Phone:     

             Fax:       

             Email:     

 

SUBJECT: Order for LNS(r) Device Credits (LNS Turbo Edition) 

Please process the following order: 

 

Number of LNS Device Credits ordered: ADD 50 

Number of LNS Device Credits to be delivered (if less than the quantity ordered): 

Product: LNS Device Credits 

Model Number: 34400 

Price Each: 

Total Amount: 
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Following are the list prices.  These prices are subject to change.  Contact your distributor for current 

and local pricing.   

Your distributor may also provide you with an alternate mailing address for this order. 

 

List price: US$1.50 

Price for authorized free uses:  No charge (see agreement below) 

 

The following PC key value is filled in automatically by the LNS Server License Wizard when you 

generate an LNS Device Credit order as described in the product documentation.  You should always 

use the order form generated by the software and send the form by email (or fax if email is not 

available) to ensure that there are no errors in transcribing the PC key value. 

 

PC Key:  DBCB A65E 06FB C480 50 - 71D7 D287 C5C1 C5FE 8E71 DCA5 82E5 CCD4 DE8E 61DD 

9A8C CA8B 

 

Select one of the following payment methods and fill in the information for the requested method: 

 

[  ]    Credit Card (minimum order of 50 credits) 

        Type of credit card:   

                [  ] American Express 

                [  ] MasterCard          

                [  ] Visa        

        Name on the credit card: 

        Credit card number: 

        Expiration date: 

 Authorized by: 

 Billing Address: 

                Street 1: 

                Street 2: 

        City: 

        Providence/State: 

        Postal/Zip Code: 

        Country: 
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[  ]    Purchase Order (minimum order of 50 credits) 

        Purchase Order Number: 

        Authorized by: 

        Billing Address: 

                Street 1: 

Street 2: 

        City: 

        Providence/State: 

        Postal/Zip Code: 

        Country: 

 

[  ]    No charge evaluation, development, test, support, production, training, or replacement credits     

(check all that apply).  By submitting an order for free credits, you agree that you will use these free 

credits only for the authorized purposes that you have checked below, and you agree that you will 

provide Echelon with information as reasonably requested by Echelon to verify that the use of these 

LNS Device Credits is limited to the authorized uses.  There is no minimum order size; maximum order 

size is indicated below. 

 

[  ]   Evaluation use.  LNS Device Credits used for evaluation purposes.   Limited to 500 free credits per 

company per year. 

                

[  ]   Internal development and test use.  LNS Device Credits used for the development and testing of 

devices that will solely will be used for development, or that will be shipped in the unconfigured state.  

Limited to 500 free credits per device type per year. 

                

[  ]  Support use.  LNS Device Credits used by a support engineer to provide support to a customer.  

The customer must have paid for the LNS Device Credits used for the customer's devices.  Limited to 

500 free credits per support engineer per year. 

[  ]   Production use.  LNS Device Credits used for manufacturing test.  Devices must be shipped in the 

unconfigured state.  Limited to 1 free credit per manufactured device shipped in the unconfigured state. 

                               

[  ]   Training use.  LNS Device Credits used solely for training.  Any devices installed during training 

must not be used in a production or operational system.  Limited to 500 free credits per class. 

 

[  ]   Replacement use.  LNS Device Credits used to replace LNS Device Credits that were lost due to               
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a PC hardware or software failure. Limited to the number of credits that were lost as a result of the 

failure. 

 

Your LNS Device Credits will be sent to you by email or fax as an Application Key (a series of numbers 

and letters).  When you receive the Application Key, run the LNS Server License Wizard again, enter 

the Application Key on the second page of the wizard and then press Finish. 
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